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How To ...

This program is handling the communication with the Supercool Regulator Board, via serial
port or USB virtual port. All data in the regulator can be saved to a file, and retrieved later for
fast test of different settings. Runtime view helps the user to adjust the parameters for best
result and it is also possible to save to runtime log file, for later analysis in other software.

Commands

E Untitled - SC_Interface
File Edit “iew Regulator Setup  Logofile  Help

File menu
for handling files, printing and exit the application.

Edit menu
for handling text editing (copy, paste etc).

View menu
for changing visible views.

Regulator menu
to send/get commands and data to/from the regulator unit.




Setup menu
for changing the global setup and for firmware download.

Loggfile menu
to handle the log file, to be analyzed in other software.

Help menu
for About dialog and this help document.

File menu commands

The File menu offers the following commands:

New Creates a new
document.

Open Opens an existing
document.

Save Saves an opened

document using the
same file name.

Save As Saves an opened
document to a
specified file name.

Revert to Default Revert all changes to
default values.

Print Prints a document.

Print Preview Displays the document
on the screen as it
would appear printed.

Print Setup Selects a printer and
printer connection.

A list of last used user
files.

Exit Exits SC_Interface
Edit menu commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.

Copy Copies data from the document to the clipboard.



Paste Pastes data from the clipboard into the document.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Regulator menu commands

The Regulator menu offers the following commands:

Connect

Disconnect

Stop

Download parameters
Get parameters

Save to FLASH

Read from FLASH
Set FLASH to default

Reboot regulator

Setup menu commands

Connect to regulator board through serial interface.

Disconnect the serial interface connection to regulator
board.

Stop the regulator run mode.
Download parameters to regulator board.
Get all parameters from regulator board.

Save all parameters to the regulators non-volatile FLASH
memory.

Read all parameters from FLASH memory to regulator
memory and upload.

Revert all parameters in FLASH memory to default
settings.

Reboot the regulator. Use to test loading of parameters from
FLASH to memory.

The Setup menu offers the following commands:

Global setup Enter global setup view. All global setting is stored in the system
registry file.
Download firmware Download new firmware in the regulator. This command can not

be terminated after start. Do not force quit the program.



Global setup
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Used to change the global settings for the program. The global values is stored in the
computers registry file.

Serial port, to select the serial port and speed. For the moment the only speed supported is
115200 baud.

Celsius and Fahrenheit selection, will change all views to the type selected.

Runtimedata should be of IEEE754 type at all time. Only change this if you are advised by
Supercool to do so.

Runtime graph can sometimes be difficult to se on some screens. Set the pen width of the
graph to meet your needs. The colors can be changed so user can more easily view the graph.
The color in the table will change directly, for easier color selections. Use Set Default Color
to get back to default values.



Download firmware

Download firmware

User selected file
Program Daka 0x0000 - 0x6864, with config data

Ci\ProgramtSC_Interface\ Targetisc w2, 3b06. hex

Downlaad information

Zancel

BL-- with id 2E7C is Unlocked

Used to upgrade the firmware in the regulator board. The Firmware is stored in the regulators
FLASH memory and is needed to be done, only one time. Press Download key for start the
download or Cancel key to exit.

The latest Target file, is installed in the Target folder of application folder.

Log file menu commands

The Log file menu offers the following commands:
Start Start logging runtime data to user file.

Start Stop logging runtime data.

When we activate the log file, we save runtime data from the regulator to a tab-separated text
file, which is easily opened in applications like Excel where you can analyze, the data. This
helps to get a better understanding of the regulator performance and also for presenting the
result in a better way.

If you select a file already existing, we are opening the file and adding data at the end of the
file.

First in the file, we get a header with info of what kind of data there will be stored in the file.
Also the software versions used.

Then the runtime data is following until the user stop the log file. Please, remember that it can
be a lot of data, because we get a block of data 20 times a second.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this
application:

Help Topics Offers you an index to topics on which you can get help.

About Displays the version number of this application.



About dialog

About SC_Interface |E|
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Superconl Interface version 1.1.7a
Copyright () 2004-2005

Supercool AE
htkps i, supercool, com
email: controllers@supercool, se

Iohan Seiberlich
Thomas Cskarsson

For software version, support web page, and support email.
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Live info from the regulator unit.

Regulator status view, is displaying live data from the regulator unit. Here is the current
software version in the regulator, indication of any error, and the last command performed.

LED The LEDs on the right side: GREEN that the serial port is open for communication,
YELLOW that we get runtime data from regulator, RED that there is an error reported from

the regulator.

Send key to download parameters and start the regulator.




Stop key to stop the regulator.

Input part, is displaying live info from AD converters, calculated with user settings, to
indicate values.

Regulator information part, is displaying the set point and temperature point used in the
regulator control loop.

Output information part, is displaying controlled output values to main output, fan 1 and 2.
The unit is in percent, for main -100% to +100% and for the fan outputs 0 to 60 Voltages.

Main User View
I| Base lRuntime] Alarm ] Fan ] Sensar ] Regulatu:ur]

The user views are a collection of views to change data values in the regulator unit. All data is
also saved in the setting file *.sc type.

e Base view - for handling base setup

e Runtime view - for getting runtime view
e Alarm view - for alarm values

e Fan view - for FAN settings

o Sensor view - for sensor settings

e Regulator view - for regulator settings

User View Base
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Base view, for quick setup of the regulator. Select temp sensor, set point and enter info for
your own information. All data will be stored in the file.

e Set point, used in the regulator.
e Temperature sensor type selection, indicating the main sensor type.
o User comment, to enter any text you like, to help you remember your settings.

User View Runtime
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Live (runtime) data view.

The live data graph is updating data when you have a connection with the regulator unit. You
can change update speed with [+] and [-] buttons. And also freeze the view if you need to.
Change line thickness in the Global setup view, if you need thicker or thinner lines.

The list on the right side is a selection of the graphs we get in the view. We can set the
min/max value of the data, to change the height resolution of the graph selected.



User View Alarm
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Alarm settings.

This view is setting the alarm values in the regulator unit. It is possible to disable all parts,
and only enable the parts valid for the regulator. If an error is trigged, the LED is flashing
while the error is active, and up to a couple of seconds after the error is cleared.

For the temperature sensor settings (T1,T2,T3 and T4), if high is active, we also check for
"shortcut", and if low is active we check for "missing sensor". This way we get total control
over the temperature sensor check.



User View Fan
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Fan control settings. This view is handling the FAN control.

Fan Mode List

Cool and heat
Algo

The FAN mode works as follows.

Mode: Off - The FAN is always off.

Mode: Always on - The FAN is always on.

Mode: Cool - The FAN is active when the regulator is in cooling mode.

Mode: Heat - The FAN is active when the regulator is in heating mode.

Mode: Cool and heat - The FAN is active when the regulator is in cooling or heating mode.

Mode: Algo - The FAN is active as result of the algorithm function.



FAN algorithm

Fan control
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FAN algo mode is handling the FAN by tracking the input temperature. The output is given
by the temperature and settings.

User View Sensor
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Sensor settings.

Select a sensor with the drop selection list. After selecting it is possible to edit this selection
with the EDIT button. The edit mode differs for sensor one, and the other sensors.

Use Copy and Paste to copy settings from one sensor place to another.

Upload parameters will replace the sensor settings at position 0, with the values found in the
regulator. At the same time the name will be renamed to "Uploaded".



Sensor 1
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Sensor 1 edit box.

This is the main sensor for the system. Here it is possible to change the name, and all
parameters that are used to calculate the temperature. This is the only sensor with the
possibility to adjust the electrical parts on the board by changing digital potentiometers.
Contact Supercool for getting help with the best value for your sensor.

Name Change the name on the sensor settings. The name is used in the drop list for you to
remember the sensor settings.

Gain is used for adjusting the sensor value. Any other value than 1.0 is effecting the sensor
value, even if Stainhart mode is selected. If unsure, use Gain 1.0

Offset is used for adjusting the sensor value. Any other value than 0.0 is effecting the sensor
value, even if Stainhart mode is selected. If unsure, use Offset 0.0

Zoom mode - when we select zoom mode, Pot gain and pot offset is controlled with an
internal algorithm for best result (default and only available for sensor one).

Pot Gain, when not in Zoom mode, is used for adjusting the electrical sensor value. Any
value is affecting the sensor value in all modes. If unsure, use Zoom mode for automatically
adjustment.

Pot Offset, when not in Zoom mode, is used for adjusting the electrical sensor value. Any
value is affecting the sensor value in all modes. If unsure, use Zoom mode for automatically
adjustment.

Steinhart mode The regulator board is calculating the temperature of an NTC resistance by
using the Steinhart-Heart equation. Normally the NTC sensor is difficult to use, but after
correct Steinhart values are selected, the temperature is very accurate in the area where the
points are selected. Note that normal values for Gain are 1, and Offset is 0, in this mode. If
gain and offset are changed, the result from the Steinhart equation is affected. Please contact
Supercool for more information.



Sensor 2,3,4

Change Temperature Calibration Data
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Sensor 2, 3, 4 edit box.
Here it is possible to change the name, and all parameters in the regulator that are used to
calculate the temperature of the sensor input.

Name Change the name on the sensor settings. The name is used in the drop list for you to
remember the sensor settings.

Gain is used for adjusting the sensor value. Any other value than 1.0 is effecting the sensor
value, even if Stainhart mode is selected. If unshore, use Gain 1.0

Offset is used for adjusting the sesnor value. Any other value than 0.0 is effecting the sensor
value, even if Stainhart mode is selected. If unshore, use Offset 0.0

Steinhart mode The regulator board is calculating the temperature of an NTC resistance by
using Steinhart equation. Normally the NTC sensor is difficult to use, but after correct
Steinhart values are selected, the temperature is very accurate in the area where the points are
selected. Note that normal values for Gain are 1, and Offset is 0, in this mode. If gain and
offset are changed, the result from the Steinhart equation is affected. Please contact Supercool
for more information.

Sensor 4 is mounted on the cooling part of the H-bridge used to control the output voltage to
the main out. Here we can get feedback to check if we cool the electronics the right way.



User View Regulator
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Regulator settings.
This is the heart of the regulator unit. Here we set the type of regulator we should use, and set
the parameters to get best performance for the task we use the regulator in.

Regulator mode list.
We can select one of following modes: Off, Power, Algo, P, PI, PD, PID mode. Depending of
the mode selected we get the regulator to function differently.

Off mode - will always keep the regulator off.

Power mode - This mode is used for directly controlling the output power. It can be useful
when determining the response of the system. You can either connect a potentiometer to the
External pot-connector, or you can feed a voltage to the center pin of the External pot-
connector where 0V=-100%, 2.5V=0% and 5V=+100%. Note that Max power out/Dead
band/Cool and Heat gain are active and might affect the output amplitude.

Tref foutEeg



Algo mode - is used to simulate "cool on"/"off"/"heat on" mode type, similar to a relay
controller.

Tewperronire confrol
(ON/OFF) - -
A Set point PRIV [/ TR
B Dread-band 0. s°C N “‘E
C Hysteresis LU i o

-+

Algo mode: Dead-band setting - is used in algo mode.
Algo mode: Hysteris setting - is used in algo mode

P, PL, PD, or PID mode - will use all or selected parts of the PID regulator. Of course it is
possible to use PID mode and only set P, I or D constant to zero, but the possibility to change
mode quickly without changing the constants helps to trim the values for optimal use.
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The picture shows the function of the PID regulator.

Tal is the input temperature, Tref is the set point, Ts is sample rate, KLP_x is filter constants,
Decay is decay constant, Te is the regulator error feeding to the PID part, kP, kI, kD is the
PID constants, iLim is limitation of I value, fOutReg is the internal value feeding to the output
block.

PID mode: Propotional (kP) - is the P constant value used in PID mode.

PID mode: Integral (KI) - is the I constant value used in PID mdoe.

PID mode: Derivative (kD) - is the D constant value used in PID mode.

PID mode: Integral value limit - is used to limit the I part. When the I part is accumulated
up to this value, it will stop.

PID mode: Lowpass Tr (kTr) - is used as a filter on the set point changes. So if we change
the set point while we are running the regulator, we are limiting the speed of the change with
this parameter.

PID mode: Lowpass Te (kTe) - is used as a filter of the Te signal. Te is the difference
between temperature sensor and the set point. All changes of this signal are filtered here.

Output block
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The main output block is handling the adjustment part before the actual output signal. We
have CoolGain, HeatGain, Dead-band and Limit values that the user can set in the interface.

Heat gain and Cooling gain - to adjust the effectiveness of the output elements. Some time
we get uneven output effect in the element. Here we can adjust so that we have even effect on
the cooling and heating part.

Dead-band - is used to limit the output control around zero. Any output lower than the value
set in this box will render 0% output. This is useful in order to avoid too fast switches
between cooling and heating in order to increase lifetime of the thermoelectric modules.

Max power out - Limit is used to set the max output value. This is always in effect. Valid
range is 0 to 100 and the unit is percent (%).

Stl - is the set point the regulator should control around.[-100..200]

Decay when stopped - when the regulator is stopped, the internal register values used in the
PID regulator, will decay to zero with the speed of the value selected here. The value should
be less than 1 and larger than zero. If 1 is selected we do not decay at all, and if 0 is selected
we clear the internal value without any decay time. Internal register is multiplied with this
value at a rate of sampling speed.

Sampling speed - is fixed for the moment with 20Hz = 0.05s

Idle, waiting for user, For Help, press Fl C oMM OFfline

Status Bar

The status bar is displayed at the bottom of the SC Interface window. To display or hide the
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus. This area similarly shows messages that describe the actions of
toolbar buttons as you press them, before releasing them. If after viewing the description of



the toolbar button command you wish not to execute the command, then release the mouse
button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:
Indicator Description

CONN  The status of serial port to regulator.

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.

& E ¥ |M P K| &

Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The
toolbar provides quick mouse access to many tools used in SC_Interface,

To hide or display the toolbar, click Toolbar from the View menu.

Global setup, Log file handling, COM port open/close, get version, send parameters, get
parameters etc.

Supercool web
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For more information.

Supercool web site: http://www.supercool.com
Software support at: controllers@supercool.se




